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LEAVING LIGHTROOM

The ON1 Lightroom
Migration Assistant is the
only technology available

that will transfer your
Lightroom settings and
keep your edits in a non-
destructive format.

INTRODUCTION

This eBook is for Adobe Lightroom users that want to
learn more about how to transfer their photos with the
non-destructive edits intact into ON1 Photo RAW.
Watch a short introduction video »

BACKGROUND

The migration assistant is an automated Al-powered
algorithm that takes the edits you have done in
Lightroom and migrates them into ON1 Photo RAW,
retaining the settings. It can migrate all of your non-
destructive edits from Lightroom into ON1 Photo RAW
and leave them in a non-destructive state. This allows you
to view and edit the various sliders and settings the same
way you can inside of Lightroom but in ON1 Photo. It will
transfer almost every edit you can perform in Lightroom
including raw processing, crop, retouching, and local
adjustments along with folders, photos, albums, and
metadata. This gives you the freedom to discontinue

using Lightroom and not lose non-destructive work.

IMPORTANT ITEMS TO KEEP IN MIND BEFORE
YOU START:

1. Your Photos Are Safe

Your original photos and your settings in Lightroom are

not modified by this process.
2. You'll Need Time

The migration to ON1 can take some time depending on
the size of your Lightroom catalog (four to eight hours for

most).

3. One and Done

The Migration tool is intended to be a one time transfer
of the Lightroom catalog to ON1 Photo RAW 2019.

COMPATIBILITY

The ON1 Lightroom Migration Assistant supports
Lightroom 6.1 and Lightroom Classic. Read the full

system requirements here »



https://www.youtube.com/embed/88SjWr1lA3k
https://on1help.zendesk.com/hc/en-us/articles/360018812371
https://www.youtube.com/embed/88SjWr1lA3k
https://on1help.zendesk.com/hc/en-us/articles/360018812371
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10 THINGS LIGHTROOM USERS NEED TO KNOW ABOUT ON1 PHOTO RAW

| see lots of questions from Adobe® Lightroom users who use ON1 Photo
RAW for Effects, but find themselves using other features in ON1 Photo RAW
more and more. There seems to be an increase in the number of people
curious about switching from Lightroom to ON1 Photo RAW. So | put
together this top ten list to help explain how ON1 Photo RAW was similar to
Lightroom and how it is different.

1. Both Lightroom and ON1 Photo RAW are non-destructive photo editors.
That means when you edit a photo in either Lightroom or ON1, the edits
are stored as instructions rather than changing the file on disk. This
makes them both fast and safe for editing photos. They both support raw
photos from hundreds of cameras, as well as most of the file formats that
photographers care about like JPG, TIF and PSD.

2. Both Lightroom and ON1 Photo RAW have robust file management tools
for browsing, finding, and managing your photos. In short, they share
many of the same fundamental concepts all non-destructive raw

processors have.

3. Browsing vs. Catalogs — The first big difference you encounter between

Lightroom and ON1 Photo RAW when you start is locating your photos.

In Lightroom, you must import or catalog all of your photos from the

beginning— a reason some people want to switch from Lightroom right

away. The import process is cataloging metadata and processing preview
versions of each photo, so it may take some time. ON1 Photo RAW uses
a browser based system to let you navigate to any drive or folder where
your photos live to view and edit them instantly. So there is no need to
import. This is great when you come back from a shoot and have
hundreds or thousands of photos you want to view. Now just because
there is no long cataloging process, it doesn’t mean that there is no
database. For each folder that you browse, the metadata for each photo
is extracted and stored in a database along with a cache of previews of
the photos so you can search and browse them even faster in the future.
ON1 Photo RAW's cataloged folders take this a step further. By marking
a drive or folder as a cataloged folder, we keep an eye on it all the time
and look for new, changed or removed photos. This way you don't get
the dreaded "missing photo” problems of Lightroom and other
database-only apps. In the background, we also extract all the metadata
and create previews so you can search across your entire cataloged folder
and view the photos instantly. Lightroom has the concept of a catalog
file. This is the document or database that stores all of your settings for
the photos you have worked on. You may need to create multiples of
these catalogs in some cases and have to open them separately and
keep track of where they live. ON1 Photo RAW uses a single database
to store everything so there is no need to create multiples or keep track

of them.




4. Viewing and Organizing Photos — Both Lightroom and ON1 Photo RAW

start in a Browse module and it is where you find, view and manage your
photos. Both Lightroom and ON1 Photo RAW only show you the photos
and supported file types and hide things like documents that may be in
the same folders. Both offer the ability to show a filmstrip and a larger
view you can zoom-in on. In ON1 Photo RAW, the compare mode lets
you compare and zoom multiple photos at once. It is very similar to the
compare and survey view of Lightroom combined into one mode. Both
Lightroom and ON1 Photo RAW offer quick ways to tag your photos for
sorting with stars, colors or a like/dislike flagging system. Metadata about
your photos can viewed and edited in both apps in a similar way. Both
support XMP, EXIF and IPTC metadata and both subscribe to the
Metadata Working Groups specification on handling metadata. Both
offer ways to store lists of photos. Lightroom calls them collections,
where ON1 Photo RAW calls them albums. Both offer a way to store
search criteria. Lightroom calls them smart collections, where we call

them smart albums.

At the core of any non-destructive photo editing, is the basic raw
processing. This includes basic adjustments like exposure, contrast,
highlights, shadows, white balance, etc. Both Lightroom and ON1 Photo
RAW provide similar basic adjustments with mostly the same names. You
will notice the different ranges and results of these sliders between
Lightroom and ON1 Photo RAW and this is largely because each app
uses a completely different raw processing engine. For example, ON'
Photo RAW has a little more contrast by default than Lightroom. Beyond
the basic Tone and Color adjustments, both apps offer a range of other
adjustments like lens correction, noise reduction, black and white, split

tone, curves, etc. Lightroom presents all of its available options as a long
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list of panes. In ON1 Photo RAW, you start with the essential panes
and click on the Show More button to add the enhancements your
photo needs.

Both apps offer great tools for cropping, retouching and local
adjustments. | think the local adjustments in ON1 Photo RAW are a little
easier to understand and are bit more flexible. They use a layer-stack
approach so it is easy to see all of the local adjustments you have added.
Each layer has a regular mask that can be edited with any of the masking
tools. This lets you combine a gradient and brush at the same time, or

even use a luminosity mask.

Both apps let you copy/paste or sync your edits across multiple photos.
And both let you save presets. Presets are a little different in ON1 Photo
RAW. First, it comes with many more presets. Second, you can preview
your presets next to each other for each comparison. Saving a preset is
less daunting as well, as there is no dialog with hundreds of checkboxes

to configure.

Both Lightroom and ON1 Photo RAW use similar keyboard shortcuts, so
you don't have to relearn old habits when you change apps. Check out
the ON1 Photo RAW shortcuts here.

Beyond the Basics — For me, the biggest difference between Lightroom
and ON1 Photo RAW comes down to two big features only found in ON1
Photo RAW — Effects and Layers. They go way beyond the basic tone and
color controls. ON1 Effects has 23 filters which include textures, borders,
glows, skin smoother, lens blur, dynamic contrast and vintage, to name a

few. You can stack and configure as many of these filters as you want to



http://www.on1.com/wp-content/uploads/2017/09/ON1PhotoRAW2017Shortcuts.pdf
http://www.on1.com/wp-content/uploads/2017/09/ON1PhotoRAW2017Shortcuts.pdf

10.

create your own unique look. Each filter has masking and blending
options built-in so you can easily target a filter to just the right area or
tonal range. Remember, this is all happening right on your raw data, non-
destructively. ON1 Layers is also a difference maker. It gives you a lot of
the power of Photoshop® right in your raw editor. You can combine
multiple photos together, which is perfect for replacing skies, blending

exposures or swapping heads.

Getting Your Photo Out — Being non-destructive editors, you need to
export a photo to share it. Both Lightroom and ON1 Photo RAW offer a
powerful export feature where you can resize, choose the file type,
watermark, sharpening, location, and naming options. ON1 Photo RAW
uses the powerful Genuine Fractals® algorithm for resizing so it
maintains all the detail of the original, no matter what size you export.
With all that power comes a lot of controls you may also need to
configure. If you simply want a photo of the same size, ON1 Photo RAW's
quick export makes it really easy to export the current photo without
having to go through the controls in the export dialog. Lightroom offers
advanced slideshow, printing and web gallery output options. Currently
ON1 Photo RAW users complete their workflows with other dedicated
apps or websites for these features. Basic printing can be accomplished
via the print dialog. Both apps also make it easy to send copies of your

photos to other external applications like Photoshop.
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MIGRATING YOUR
LIGHTROOM CATALOGS

A PRIMER ON RAW PROCESSING
In 2017, we added support for basic migration of Adobe® Lightroom

catalogs. This migrated folders and photos as well as basic collections and
metadata. It could also create copies of edited photos with the Lightroom
edits processed or “burned” into the photos. It could not, however, do the
final step, the holy-grail of migration, which is to migrate the actual
Lightroom edits in a re-editable, non-destructive way. And for a good reason,
it is a very difficult problem. First-off, there is a bit of technical ground we
need to cover: processing a RAW photo into something pleasing in a multi-
step process. First, you have to decode the often compressed data. Then
comes the debayering, the step that actually converts the RAW data into an,
albeit dark and ugly, RGB image. That's the first bit of magic.

The second comes in actually making that photo look like what you saw
through the camera. This includes adjusting the whitepoint, applying a
gamma curve and other camera specific adjustments including color, camera
profiles, reducing noise, correcting for hot pixels and lens distortion. That's
all just to get something that looks normal. Every RAW processor is different
and uses many algorithms just to get to this point. When we start to talk
about even the basic RAW adjustments like shadows, highlights, contrast,
whites and blacks there is even more magic to accurately target those areas
and do the right thing. So what does this mean when we talk about migrating
the settings from Lightroom to Photo RAW, you may ask? Well, it means that
it's not a simple process of just copying the slider values from Lightroom.

For example, a shadows slider value of +50 in Lightroom won't yield the
same results in Photo RAW. In fact it's even more complicated, as the visual
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results for a given control value change from photo to photo, they are
adaptive. In order to get the same visual results, and that's what we are really
talking about here, we have to visually compare the results from Lightroom
and determine what the corresponding settings would be in Photo RAW to
give you the same appearance. And that has to be done for every photo! To
solve this problem, we developed a fast, machine-learning, algorithm that

does just that.



https://www.youtube.com/embed/z4EmGFTPfhM
https://www.youtube.com/embed/z4EmGFTPfhM
https://www.youtube.com/embed/z4EmGFTPfhM
https://www.youtube.com/embed/z4EmGFTPfhM
https://www.youtube.com/embed/z4EmGFTPfhM
https://www.youtube.com/embed/z4EmGFTPfhM
https://www.youtube.com/embed/z4EmGFTPfhM
https://www.youtube.com/embed/z4EmGFTPfhM
https://www.youtube.com/embed/z4EmGFTPfhM
https://www.youtube.com/embed/z4EmGFTPfhM
https://www.youtube.com/embed/z4EmGFTPfhM
https://www.youtube.com/embed/z4EmGFTPfhM
https://www.youtube.com/embed/z4EmGFTPfhM
https://www.youtube.com/embed/z4EmGFTPfhM
https://www.youtube.com/embed/z4EmGFTPfhM
https://www.youtube.com/embed/z4EmGFTPfhM
https://www.youtube.com/embed/z4EmGFTPfhM
https://www.youtube.com/embed/z4EmGFTPfhM
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WHAT MIGRATES

Lightroom Feature Migrated Notes

Folders Yes All top-level Folders in Lightroom become top-level cataloged folders in Photo RAW

Photos/Videos Yes All photos/videos in the cataloged folders are added. This may include some photos that are not cataloged in
Lightroom. Photo RAW only migrates available photos and does not migrate photos from offline volumes. Only
files of supported file types and color modes will appear.

Versions Yes

Stacks No

Collections Yes All normal collections are migrated to albums. Collection sets become album sets. Smart collections are
not migrated

Crop Yes

Spot Removal Yes Spot Removal is migrated to the Clone Stamp when used in Clone mode. When used in Heal mode it is migrated
to the Perfect Eraser. The results will not be a pixel perfect match but will generally remove the same spots with
comparable results.

Basics Yes Camera Profiles are matched for Adobe® and Camera profiles. Other LUTs or custom profiles are not migrated.
Clarity is called Structure in Photo RAW. Dehaze is called Haze and will look a bit different. The quality of the results
is very good for most photos.

Black & White Yes You will find this in the Black & White filter in Effects

Tone Curve Yes Parametric curve adjustments are not migrated, but point-based curves are.

HSL/Color Yes You will find this in the Color Adjustment filter in Effects

Split Toning Yes You will find this in the Split Tone filter in Effects. Colors will be close but not exact

Detall Yes There are significant differences in the sharpening and noise reduction algorithms. We did our best to align them

but they may require manual adjustments to taste before output
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WHAT MIGRATES

Lightroom Feature Migrated Notes

Lens Correction Yes We will apply automatic lens correction if we have a matching lens profile. Manual distortion settings are not
migrated

Transform No Unfortunately Transform is very different and we couldn’t find a practical way to migrate these settings. You can
achieve similar results using the Transform pane in Develop in Photo RAW.

Effects Yes You will find these in the Vignette and Film Grain filters in Effects.

Calibration No

Red Eye No You can reduce red-eye automatically in the Portrait module

Graduated Filter Yes You will find these as adjustment layers in the Local module using the Adjustable Gradient. Range mask, Moire and
Defringe are not migrated at this time.

Radial Filter Yes You will find these as adjustment layers in the Local module using the Adjustable Gradient. Range mask, Moire and
Defringe are not migrated at this time.

Adjustment Brush Yes You will find these as adjustment layers in the Local module using the Adjustment Brush, including the Auto Mask

function. Range mask, Sharpening, Moire and Defringe are not migrated at this time.

For most photos, where you have done basic raw adjustments, cropped, retouched and maybe added a couple of local adjustments, your migrated settings and
visual results will be very close. There are some cases, such as JPG original photos, captured under difficult lighting situations with lots of edits that may not be as

close. Keep in mind that your original photos and your settings in Lightroom are not modified by this process, so everything is safe.
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STARTYOUR MIGRATION

PREPARING

Are you ready or thinking about making the switch from Lightroom to ON1 Remember, Lightroom is a non-destructive editor so all the metadata

. . changes and the edits you've made are in Lightroom’s catalog file, not in
Photo RAW? If so, we want to make your transition as smooth as possible. 9 s youv n -9 gme I

We broke the most common method down into 4 steps to make it easier the photos themselves. Fear not— we want you to maintain as much as you

to follow along when making the switch from Lightroom can from Lightroom so your time is not wasted. Our Lightroom Migration
Assistant helps tremendously when you are ready to make the switch from

Lightroom to ON1 Photo RAW. There are some key steps in this process
to prepare first.

BACK UP YOUR LIGHTROOM CATALOG

We recommend you backup your Lightroom catalog before starting the
migration process. You can learn more about how to backup here »



https://helpx.adobe.com/lightroom/help/back-catalog.html
https://helpx.adobe.com/lightroom/help/back-catalog.html

PAGE # 10

MIGRATING TO ON1

STEP 1: FIND YOUR PHOTOS MR o eadats

C . gy You can also "Synchronize Folder", "Find A e
onnect any external drives or shares containing photos you want to New Smart Collection...

migrate. Then use the Sync Folder command in Lightroom to make sure your all missing photos" and *Validate DNG New CollecugritEss

Lightroom catalog and the actual files are up-to-date. This will add any Files" from the "Library” menu at the top. New Fo

photos that Lightroom is missing as well as remove broken links._In addition flncs

to connecting all drives, we recommend Synchronizing your folders, finding Enabe Filters

all missing files and validating all DNG files prior to starting the Lightroom E:::Zi 3 E;’:;et

migration process. To do this, right click on the folders on the left side of Filter by Rating

Lightroom's Library module and choose "synchronize folder": Filter by Color Label
Filter by Kind

Filter by Metadata
v/ Show Photos in Subfolders

Vv Catalog

All Photographs 1459

AllSynced Photographs Refine Photos...

Quick Collection +

Previous Import
Rename Photo...
Convert Photo to DNG...

Vv Folders

Find All Missing Photos
Validate DNG Files
Synchronize Folder...

Move Selected Photo to this Folder

Create Folder Inside “2017"...

Create Collection Set “2017"..
Create Collection “2017"... . o
Find Faces Again...
Mark Favorite

Add Color Label Previews

Rename...
Remove...

Hide This Parent
Show Parent Folder

Find Previous Process Photos

Previous Selected Photo B
Next Selected Photo ¥

Save Metadata
Synchronize Folder...
Update Folder Location...
Plug-in Extras >

Import to this Folder...
Export this Folder as a Catalog...

Show in Finder
Get Info




MIGRATING TO ON1

STEP 2: PRE-ORGANIZE!

Take this opportunity to remove any photos, virtual copies or collections you
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don't care about. It's also a good time to reorganize your folders if necessary.

Keep in mind we will only migrate photos that have edits in Lightroom;

photos in the catalog with no edits will appear in ON1 identical already.

Large Catalogs - If for example you have 10,000 photos in your Lightroom
catalog and lots of edits... Yes, you can migrate the entire catalog, but it will
take a very long time, and may not be practical. There is another option you

may want to consider for the pre-organizing step.

1. Use Lightroom’s Filter and Search functions to narrow down the number
of photos you want to select for migration.
In Lightroom go to File > Export as Catalog.

Open the new catalog and proceed to step 3.

New Catalog...
Open Catalog... 4380
Open Recent >

Optimize Catalog...

Import Photos and Video... 38l
Import from Another Catalog...
Import a Photoshop Elements Catalog...

Tethered Capture >
Auto Import >
nport De

Export... {4 $E
Export with Previous X+ $E
Export with Preset >
Export as Catalog...

Email Photo... 4 8M
Plug-in Manager... 88,
Plug-in Extras >
Show Quick Collection 3B
Save Quick Collection... X ¥B
Clear Quick Collection 3B
Library Filters >
Page Setup... 43P

Printer... $P




MIGRATING TO ON1

STEP 3: MAKE THE SWITCH

To migrate your catalog, open it inside Lightroom, and choose Migrate
Catalog to ON1 Photo from File > Plug-In Extras.

Intro tab: An assistant window will open up; the first screen has an

introduction about the process. If you would like to see any additional
up-to-date information on the Migration Assistant, click the Learn More
button, which will take you to a help page on the ON1 website. Click
Next when you're ready.

Prepare tab: This tab will provide you with more information about the
process. Much of the same information is in this eBook. When you
understand, click Next to view the Settings tab.

Settings tab: Choose if you want to migrate your collections and
Develop settings. For most of us, you will want both of these on.
Copies tab: If you want to create rendered copies of your photos. This
will make non-editable copies of any photos in Lightroom that have
Develop settings applied to them. For most of us, you will leave this
option off.

Press the Migrate button and wait. The process can take a long time
depending on the number of photos that you have. It does work in the
background, just leave Lightroom open and it will do its work. It's a good
idea to start this at the end of the day and let it run overnight.
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Migrate to ON1 Photo

Prepare  Settings  Copies

Welcome to the ON1 Photo RAW 2019
Lightroom® Migration Assistant

IMPORTANT ITEMS TO KEEP IN MIND BEFORE YOU START

1| Your Photos Are Safe

Your original photos and your settings ot modified by this praces:

2| You'll Need Time

N1 Ph

your L
3| One and Done

igrat

Have Questions? Click Learn More Below.

Learn More Next Cancel

Migrate to ON1 Photo

Intro Settings  Copies

The ON1 Photo RAW Migration Assistant will migrate most of your Lightroom
catalog settings to ON1 Photo RAW. The assistant can migrate these items:

« Your top-level folders in the Folders pane in Lightroom will become Cataloged
Folders in ON1 Photo RAW. All the photos and videos inside of these folders will
be cataloged automatically.

« Metadata changes made in Lightroom will be migrated and include keywords,
descriptions, ratings, labels, orientation, etc.

« Your collections can be migrated as well.

= RAW processing and editing settings from Lightroom's Develop module
including crop, retouching, and local adjustments are migrated non-destructively
50 they can be re-edited in ON1 Photo RAW.

Please attach any drives that contain photos in the catalog before you begin. Use
the Synchronize folder option in Lightroom to make sure your catalog is up-to-
date.

NOTE: The migration process can take a long time. You can continue to use Lightroom and
ONT Photo during the migration. This tool is intended for one-time migration of catalogs, not
continual syncing of changes. The migration process can also temporarily use a large amount
of hard disk space on your main drive. Please back-up your Lightroom catalog and make sure
you have plenty of space before you begin.

Learn More Previous  Next Cancel

Migrate to ON1 Photo

intro Prepare [JEELGFTH Copies

Migrate Collections

All normal collections and collection sets will be migrated. Smart
collections will not be migrated.

Migrate Lightroom Develop Adjustments

For any photos that have editing settings applied, we will migrate
those settings non-destructively so you can re-edit them. This
includes RAW processing options as well as crop, retouching and
local adjustments.

Note: ON1 Photo RAW uses a different RAW processing engine than Lightroom. We use
machine learning to visually match the results from Lightroom. Your control settings will have
different values than what you see in Lightroom. In most cases the visual match s very close.
To learn more about what exact settings are migrated, click the Learn More button below.

Learn More Previous | Next Cancel

Migrate to ON1 Photo

Intro  Prepare  Settings

Create copies of photos with Lightroom Adjustments

Any photos that have editing settings applied will have rendered
copies made with the Lightroom settings. These are NOT re-
editable and will be stored in the same folder as the original.

Copy Options

File Format: <
Color Space: B8
Bit Depth: S Resolution: e

Learn More Previous Cancel Migrate




MIGRATING TO ON1

STEP 4: STARTTO EDITIN ON1

Once the migration process is completed, you will see the same folders that
are in the Folders section of the Library module in Lightroom in the
Cataloged Folders pane in the Browse module of Photo RAW. You will be
able to navigate the folders in the same way. Your collections will appear in
the Album pane. When you look at photos they may have a small “LR" badge
on their corner. This means they have Lightroom settings for them that have
not been interpreted in ON1 Photo RAW settings yet. In the background we
scan the photos and perform the translation. If the photos have the “LR”
badge this hasn't been accomplished yet. Don't worry, when you open a
photo to edit it, this is done on the fly and the photos appearance will update
as well as it's thumbnail and preview in Browse. All of the non-destructive
settings will be applied and you can adjust them in the Edit module. If you
want to remove the settings and start from scratch, you can press the Reset
button.

IMPORTANT

The migration process can take some time, especially if you select the copy
with Lightroom adjustments option. You can continue to use Lightroom and
ON1 Photo during the migration process. The Migration Assistant is intended
for one-time migration of catalogs, not continual syncing of changes.
However, if you have more than one Lightroom catalog, you can use the
Migration Assistant again on each catalog to merge them into one ON'
Photo RAW installation.
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FAQ

Q: Who is it for?
A: It is for any and all Adobe Lightroom users that want to transfer their
photos (with the non-destructive edits intact) into the ON1 Photo catalog,

and keep them in a non-destructive format.

Q: What is it?
A: Itis an automated Al-powered algorithm that takes the edits you have
done in Lightroom and migrates them into ON1 Photo RAW, retaining the

settings.

Q: What can it do?

A: It can migrate all of your non-destructive edits from Lightroom into ON1
Photo RAW and leave them in a non-destructive state. This allows you to
view and edit the various sliders and settings the same way you can inside
of Lightroom, but in ON1 Photo. It will transfer almost every edit you can
perform in Lightroom including raw processing, crop, retouching and local
adjustments along with folders, photos, albums, and metadata. This gives
you the freedom to discontinue using Lightroom and not lose non-

destructive work.

Q: How does it work?

A: After you install ON1 Photo you open Lightroom and click File > Plug-in

Extras > Migrate Catalog to ON1 Photo. This will bring up a modal dialog as

the first step. Learn more about the migration process here.
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Q: How accurate is it?

A: It's quite good on most raw photos. For raw photos, where you have done
basic raw adjustments, cropped, retouched, and maybe added a couple local
adjustments, your migrated settings and visual results will be very close.
There are some cases, such as JPG original photos, captured under difficult
lighting situations with lots of edits that may not be as close. Keep in mind
your original photos and your settings in Lightroom are not modified by this

process, so everything is safe.

Q: How fast is it?

A: Not very. There is a lot going to make this happen and people tend to
have tens of thousands of photos in their Lightroom catalogs. The process
will take most users four to eight hours. On the plus side, it can run in the
background and you can continue your normal work. A good idea is to start
it at night when you are done with your work and by morning it should be
done. Let me give you some deeper insights on how long it takes in our

testing that you can apply to your scenario.

For these tests we are working on a couple year old mid-range Lenovo
laptop with an Intel Core i7 processor. The photos are stored on a slow
external USB 2 drive. This is pretty common set-up for many of us. For

this test we had a catalog of 5000 photos. It's a mix of RAW and JPG with

a few PSDs thrown in for good measure. We had edits on every photo.
This would simulate a user who uses a preset on import. Keep in mind
many users only apply settings (make edits in the Develop module) on a
smaller percentage of their photos. In our test it took as average of 3 hours

to complete the migration.




If you scale these numbers up to a more normal catalog of 50,000 photos
where only 25% of the photos have edits, on the same computer it will take

about 7.5 hours to complete.

How can you make it faster you might ask? The longest portion of the
migration process is Lightroom generating the small JPG photo for
matching, that's about 80% of the time spent. So to make it faster, only
migrate photos with settings that really matter to you. If you have done super
basic adjustments like only turning on lens correction or adjusting white
balance or noise, reset those settings. You can batch apply them quickly

again in Photo RAW after the migration.

Q: How much extra space does it need?

A: When the migration process is performed we need to make a small JPG
version of your photo with Lightroom'’s settings applied for comparison. Each
file takes about 125Kb, or about 625Mb per 5000 photos that are migrated.
These are temporary files and are removed automatically over time. They are
stored in the application cache which is located on your boot drive. Keep in
mind we only need to create these temporary files for photos you have made

Develop module adjustments to in Lightroom.

Beyond these small temporary files, we are not actually creating a new
version of the image file on disk unless you select “create a copy.” We will
create a very small ~5KB .on1 and .onTmeta sidecar file for each photo that
serves as the host for those non-destructive edits (which are stored in the
Lightroom catalog). The .on1meta files are also temporary and are removed

automatically over time.

Q: Does it migrate my collections?
A: Any normal collections, the ones you drag and drop photos into, and their
contents will be copied over as Albums. If you have used collection sets, their

organization will be maintained as well. Unfortunately Smart Collections will
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not be migrated, but you can create Smart Albums later inside ON1 Photo,
which are similar.

Q: Does it migrate my presets?

A: No, it will not migrate over the Lightroom Presets. It will migrate the
photos you have applied presets to and give you a very close visual match for
the photo.

Q: What files/folders/file types get migrated?
A: All top-level Folders in Lightroom become top-level cataloged folders in
Photo RAW.

Q: What does it not migrate?

A: Red eye correction, photo stacks, and adjustments from the Calibration
and Transform panes. In ON1 Photo we offer a red eye correction tool, use
subfolders instead of stacks and have our own Transform and Color Profile

panes for making these corrections after the migration.

Q: Does it sync in both directions?

A: No, the Migration tool is intended to be a one time transfer of the
Lightroom catalog. Once the migration of a catalog completes ON1 will
write it to our database and that will not be overwritten if you attempt to

migrate the same files again.

Q: | have more than one Lightroom catalog, will it still work?

A: Yes, you just need to migrate each catalog, one at a time.

Q: What happens if | already have non-destructive settings on the same
photo in ON1 Photo RAW?
A: We will ignore Lightroom settings when you attempt migrate and the file

will remain the same.
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Q: What about Keywords? Metadata, Location, People, Keyword List?
A: All metadata on a per photo basis will migrate over, the master keyword
list will get recreated from those photos. Keywords in Lightroom that are not

associated with any files will not be migrated.

Q: Can | select which photos to migrate?

A: Yes and no. We recommend you audit your catalog first, and remove any
photos you don’t want or need to speed up the process. You could also
select just the photos you want to migrate and create a new catalog with only
those photos and then migrate.

Q: What happens to my original photos and Lightroom catalog?
A: Nothing, they will still live in your Lightroom catalog and all the settings

will remain intact.

Q: What is a .on1meta file?
A: These are temporary sidecar files that hold the settings for the migration.

They will automatically delete themselves once the migrate completes.

Q: Will Lightroom “Virtual Copies" be migrated?
A: Yes. All Virtual Copies in your Lightroom catalog will migrate over during

the process as “ON1 versions.”

Q: Will the migration process create and write files to disk for virtual copies?
A: No, they will be "ON1 versions" visible only inside ON1 Photo RAW.
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ADDITIONAL RESOURCES

VIDEO TRAINING

Migrating from Lightroom to ON1 Photo RAW 2019 | Watch »

Leaving Lightroom Behind with Dan Harlacher | Watch »

ON1 Photo RAW 2019 Video Training | View Library »

WRITTEN INSTRUCTIONS

ON1 Photo RAW 2019 User Guide | Download »

Knowledge Base »

Contact ON1 Support »



https://www.on1.com/blog/migrating-from-lightroom-to-on1-photo-raw-2019/
https://www.on1.com/blog/leaving-lightroom-behind-with-dan-harlacher-on1-live-week/
https://www.on1.com/products/photo-raw/getting-started/
http://ononesoft.cachefly.net/content/ON1-Photo-RAW-2019-User-Guide-2019.zip
https://on1help.zendesk.com/hc/en-us
https://on1help.zendesk.com/hc/en-us/requests/new
https://www.on1.com/blog/migrating-from-lightroom-to-on1-photo-raw-2019/
https://www.on1.com/blog/leaving-lightroom-behind-with-dan-harlacher-on1-live-week/
https://www.on1.com/products/photo-raw/getting-started/
http://ononesoft.cachefly.net/content/ON1-Photo-RAW-2019-User-Guide-2019.zip
https://on1help.zendesk.com/hc/en-us
https://on1help.zendesk.com/hc/en-us/requests/new
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